Live
Version 6
# Table of Contents

## 1 Introducing Live
- **About**
  - Live
  - Introducing Live
- **How do I?**
  - Use Live to match move
    - Load Live
    - Use Live control panels
      - Switch between control panels
      - Turn off the Live control panel

## Reference
- **Menus**
  - Live menu set
- **Windows and editors**
  - Live playback tools
    - Playblast movies
    - Time Slider
- **Setting up shots**
  - About
    - Live
    - Setting up shots
  - How do I?
    - Use Live to match move
    - Set up shots
      - Load images
      - Depth and frame range
      - Set up filmback and aspect ratios
        - Why set the filmback?
      - Set up image cache
        - To playback images
        - When to disable image cache
      - Other Maya setup
      - Deinterlacing video shots
        - Interpolate scanlines on both fields
## Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interpolate scanlines on half of the fields</td>
<td>22</td>
</tr>
<tr>
<td>Create proxy images</td>
<td>23</td>
</tr>
<tr>
<td>Lower resolution</td>
<td>23</td>
</tr>
<tr>
<td>Luminance images</td>
<td>23</td>
</tr>
<tr>
<td><strong>3  Shot strategy</strong></td>
<td>25</td>
</tr>
<tr>
<td>About</td>
<td></td>
</tr>
<tr>
<td>Live</td>
<td>25</td>
</tr>
<tr>
<td>Shot strategy</td>
<td>25</td>
</tr>
<tr>
<td>Choosing good points</td>
<td>25</td>
</tr>
<tr>
<td>What helps the solver</td>
<td>25</td>
</tr>
<tr>
<td>What helps the tracker</td>
<td>26</td>
</tr>
<tr>
<td>Constraint strategies</td>
<td>27</td>
</tr>
<tr>
<td>Using infinite points</td>
<td>27</td>
</tr>
<tr>
<td>Survey constraints and camera movement</td>
<td>28</td>
</tr>
<tr>
<td>Problematic shots</td>
<td>28</td>
</tr>
<tr>
<td>Production tips</td>
<td>30</td>
</tr>
<tr>
<td><strong>4  Tracking</strong></td>
<td>31</td>
</tr>
<tr>
<td>About</td>
<td></td>
</tr>
<tr>
<td>Live</td>
<td>31</td>
</tr>
<tr>
<td>Tracking</td>
<td>31</td>
</tr>
<tr>
<td>Related topics</td>
<td>31</td>
</tr>
<tr>
<td>How do I?</td>
<td></td>
</tr>
<tr>
<td>Use Live to match move</td>
<td>31</td>
</tr>
<tr>
<td><strong>Track</strong></td>
<td>31</td>
</tr>
<tr>
<td>Overall tracking workflow</td>
<td>31</td>
</tr>
<tr>
<td>Track a point</td>
<td>32</td>
</tr>
<tr>
<td>Size track boxes</td>
<td>34</td>
</tr>
<tr>
<td>Evaluate a track point</td>
<td>35</td>
</tr>
<tr>
<td>Trace lines</td>
<td>35</td>
</tr>
<tr>
<td>Correct track failure</td>
<td>36</td>
</tr>
<tr>
<td>Corrective methods</td>
<td>36</td>
</tr>
<tr>
<td>Delete frames from track data</td>
<td>37</td>
</tr>
<tr>
<td>Delete and deactivate track points</td>
<td>38</td>
</tr>
</tbody>
</table>
### Table of Contents

Filter track points for interlaced shots ........................................... 38  
Review the Track Summary ............................................................. 39  
  Navigation commands .................................................................. 40  
Determine when you’re ready to solve ............................................ 40  
  Number of track points .............................................................. 41  
Use the Track Display panel ............................................................ 41  
  Display colors ....................................................................... 42  
Track Options panel ................................................................. 42  
Import track points .................................................................... 45  
Export track points ..................................................................... 45  
Tracked point file format ............................................................. 45  
Example tracked point file .......................................................... 46  

### 5 Solving .................................................................................. 49

#### About

Live ............................................................................................ 49  
  Solving .................................................................................. 49  
  Related topics ...................................................................... 49  

#### How do I?

Use Live to match move .............................................................. 50

Solve ......................................................................................... 50

  Overall solve workflow ......................................................... 50  
    Reference geometry workflow ........................................... 50  
    Use the Solve control panels ............................................ 50  
  Run the solver ........................................................................ 51  
    Root Frame step descriptions .......................................... 52  
  How the solver computes a solution ...................................... 53  
    Measuring success ............................................................ 53  
    Start and Continue ........................................................... 54  
    Refine ................................................................................ 54  
    Finish ................................................................................ 54  
    Smoothing and Filtering .................................................... 54  
    Registration ....................................................................... 55  
    Summary .......................................................................... 55  
  Evaluate a solution ............................................................... 55
# Table of Contents

- Review the Locator Summary ........................................... 58
- Improve solutions .................................................... 59
  - Add or improve track points .................................. 59
  - Remove bad track data ........................................... 59
  - Add constraints .................................................. 59
  - Eliminate inconsistent constraints ........................... 60
  - Adjust the number of root frames .............................. 60
  - Modify the choices for root frames ............................ 60
  - Adjust the Smoothing Interval. ................................. 61
  - Adjust the Filter Level ......................................... 61
  - Move the camera into an approximate starting position 62
  - Fine tune the camera ............................................. 62
  - Change the camera rotation order .............................. 62
- Choose survey constraints ........................................... 63
  - Point constraints .................................................. 63
  - Distance constraints ............................................. 63
  - Plane constraints ................................................. 64
  - Depth constraints .................................................. 65
  - Using Registration only .......................................... 65
- Create and modify survey constraints ............................ 65
  - General guidelines ................................................ 66
  - Placement of Plane and Point constraints .................... 68
  - Modify survey constraints ....................................... 68
- Create infinite and locked points ................................ 68
- Create a focal length constraint .................................. 69
  - Determine focal length settings ................................ 70
  - Example focal length settings .................................. 70
- Create camera translation and rotation constraints ........... 72
- Render a solution ..................................................... 72
  - Using CG backgrounds ........................................... 73
- Export a solution ..................................................... 73
  - Versions supported ............................................... 73
  - Export to Softimage on another machine ....................... 74
# Table of Contents

## 6 Fine tune and corrections ................................. 77

### About

**Live** ......................................................... 77
Fine tuning and corrections ................................... 77
Related topics .................................................. 77

### How do I?

**Use Live to match move** ................................. 77
**Fine tune and correct** ...................................... 77
Fine Tune ....................................................... 77
Using Nudge Tools ............................................ 77
Corrective options ............................................ 78
Correct the time unit ........................................ 78
Correcting the filmback setting ............................. 79

## Index .......................................................... 81
Table of Contents
Introducing Live

Live simplifies match moving—where you match the camera or object movement of a live-action shot. To quickly learn the basics of Live, see the Live lesson in Chapter 6, “Live,” of Getting Started with Maya Unlimited.

How do I? Load Live

Although Live is installed with Maya Unlimited, you’ll need to load it in order to see the Live menu set.

1. Select Window > Settings/Preferences > Plug-in Manager.
2. In the Plug-in Manager, click the loaded checkbox next to mayalive. If you want Live to load automatically each time you launch Maya, click the auto load checkbox.
3. Close the Plug-in Manager window.
4. Select the Live menu set.
5. Select Scene > New MatchMove.

Note: You can use other parts of Maya while Live is still loaded. Choose Scene > Live Controls to turn off the control panel, then switch to another menu set, such as Animation.
Use Live control panels

When you choose New MatchMove, Live places a control panel at the bottom of a standard Maya window. The control panel is where you control most of the Live operations. There are different control panels for each of the main tasks: Setup, Track, Solve, and Fine Tune.

Above the control panel, Live also configures preset view panels. The view panels match the needs of each task. For example, the Track task has a shotCamera, pointCenteredCamera, and Track Summary view panel.

Switch between control panels

There are several menus that let you switch between Live control panels:

- on the left side of any Live control panel
- on the pop-up menu by right-clicking in any Live control panel
- under the LivePanels menu. The LivePanels menu is on the main Maya window and the hotbox when you press spacebar.
1 | Introducing Live

Reference > Turn off the Live control panel

Turn off the Live control panel
At times you may want to turn off the Live control panel to free screen space. You can toggle the control panel on and off by choosing Scene > Live Controls. You can also press F6 as a keyboard shortcut.

Reference Live menu set
The Live menus (Scene, Track, Solve, LiveConstraints, and LivePanels) include the main commands from the Track and Solve control panels. In addition, the Scene menu contains commands for exporting your finished solution and the Track menu contains commands for importing and exporting track points.

Live also includes right-click pop-up menus for quick access to the Live control panels and the Track Summary panel commands.

Live playback tools
There are two ways to play through your shots and point tracks: Playblast movies and the Time Slider.
Playblast movies

Playblasts and Pointblasts are movies Live creates in system memory and displays in a Movieplayer window. The Movieplayer has standard playback buttons, and you can scrub through the sequence by click-dragging right to move forward or left to move backward.

Playblast and Pointblast are efficient, but they are not dynamic because of the time it takes to create the movies.

Time Slider

At the bottom of the Maya window are the Time Slider playback tools. By default, Live uses an image cache to run the Time Slider so that it plays from fast system memory. However, if you do not have enough system memory or you do not set up the image cache, the Time Slider may be too slow. See “Set up image cache” on page 18 for more information.
Setting up shots

About

Setting up shots

The first task in Live is to set up your live footage images. Learn how to set up your shots and other recommendations related to preparing them for tracking and solving.

How do I? Set up shots

Load images

The left side of the Setup control panel is for loading images.

Live supports the standard Maya image file formats:

Alias (.als), Bitmap (.bmp), Cineon (.cin), Explore (.tdi), GIF, JPEG (.jpg), MAYA (.iff), PostScript (.eps), Quantel (.yuv, .qtl), Silicon Graphics (.rgb, .sgi, .bw, .icon), Softimage (.pic), Sony Playstation (.tim), TIFF (.tif, .tiff), Targa (.tga), Wavefront (.rla)

Live also supports the standard Maya image numbering formats:
name.###.ext, name.ext.###, and name.####.

To load images

1. In general, click Browse next to Full Res Image. In the browse window, pick any image in the sequence. However, before you load images, note the following advice:
   - For video images: If the video images are interlaced, you should first deinterlace them. See “Deinterlacing video shots” on page 21.
   - For large film images (greater than 1.5Mbytes per image): First create lower-resolution proxies or a movie file of the full resolution images. Proxies are recommended to avoid performance problems. See “Create proxy images” on page 23 for instructions on creating proxies.
2 Specify proxies in either the Full Res Image setting or the Proxy Image setting. You can also specify both full resolution and proxy images. By specifying both, all scrubbing and interaction uses the fast proxy files, and tracking uses the more accurate full resolution files.

Depth and frame range
The following settings are optional:

Image Depth
Sets the distance between the 3D camera and the image plane. Click Auto-compute off to modify this setting. In most cases, leave Auto-compute on, because it ensures that 3D locators appear in front of the image plane.

Frame Range
Loads a portion of the frames in a directory. All tracking and solving will default to this range of frames.

Warning
The logo image that defaults in the Full Res Image setting must be either overwritten or cleared. Otherwise, Live assumes you intend to track against the logo image. Make sure to press Enter for the change to occur.

Set up filmback and aspect ratios
The right side of the Setup control panel is for setting the appropriate filmback and other aspect ratios. (Aspect ratio is the image width divided by height and filmback is the ratio for the exposed film negative.)

Why set the filmback?
Why not ignore the filmback and use the aspect ratio of the images on disk? You could do this; in fact, the default setting, Same As Image Aspect, does just that. However, without knowing the filmback, Live has
no way of deriving the correct angle of view (camera aperture) and focal length, so your rendered images may not match the original footage. The following illustration demonstrates this relationship between filmback, focal length, and angle of view.

Live cannot assume what filmback was used based on the current image size; you must specify it. The reason is that the aspect ratio of images often changes when you scan or transfer them to digital files. For example, film scanners often crop images.

You can check how Live’s predefined filmbacks affect the camera settings by opening the shotCameraShape node in the Attribute Editor (right-click the camera and select shotCamera). The attributes affected are Angle of View, Camera Aperture, and Film Aspect Ratio.

Live sets the camera’s focal length to 35mm by default. If you want to enter a different focal length or have Live calculate it for you, you must set a filmback and change the camera constraints. For more information, see “Create a focal length constraint” on page 69.

**To set up filmback and aspect ratios**

1. Choose a filmback from the Predefined Filmbacks list that best matches how your sequence was shot.
   - For film scanned from negative: Choose from the 16, 35, or 70 mm filmbacks.
   - For film transferred to video: Choose a filmback or one of the HDTV settings. Do not choose Video Source.
   - For a scene shot on video: Choose either Video Source or HDTV from Video Source (16:9).

2. Verify the values set by Live; in most cases, leave the defaults.
2 | Setting up shots
How do I? > Why set the filmback?

Film Aperture

The standard width and height measurements of the filmback.

Device Aspect Ratio

The aspect ratio for the final output device when you render. Live bases it on the Film Aperture settings by dividing the width by height and multiplying it by the lens squeeze, which is assumed to be one.

| Note | The device aspect ratio may differ slightly from the industry standard terminology. For example, the aspect for Super 16mm is typically called 1.66, but the actual value is 1.688. Also, the anamorphic aspect ratio is called 2.35 but is actually 2.361. |

Pixel Aspect Ratio

The aspect ratio of each pixel, which may be square (1.0) or non-square, such as for PAL video. This setting is display-only, but you can change it by turning off Auto-compute. When auto-computed, Live chooses the values from one of the following standards:

- 1.0 (square)
- 1.067 (PAL)
- .45 (NTSC, half height)
- .9 (NTSC)
- 2.0 (anamorphic)
- .50335 (PAL, half height)

3 If the Ready To Track button is red, follow the instructions in the next topic, “To correct Ready To Track errors.”

4 Click Copy to Render Globals if you eventually want to use Maya to render this shot.

Live copies the aspect ratios to the resolution settings in the Maya Render Globals. If you make changes in the Setup, click Copy to Render Globals again to update the Render Globals settings.

If you have the Render Globals window open already, the new settings might not appear. Close and open the window to refresh the settings.
To correct Ready To Track errors

When the Ready To Track button is red, it means Maya Live has detected an inconsistency between the device aspect ratio (which is set when you choose a filmback) and the actual image aspect ratio. Live detects the inconsistency based on the following relationships:

\[
\text{Device Aspect Ratio (AR)} = \text{Image AR} \times \text{Pixel AR}
\]

\[
\text{Device Aspect Ratio (AR)} = \text{Filmback AR} \times \text{Lens Squeeze}
\]

The inconsistency typically occurs because your images were cropped during the scan or transfer to digital images.

1. Make sure you have chosen the correct filmback
   Ideally, you can obtain this setting from the cameraman or director. If you can’t, try different settings because some of them have slight differences.

2. Click the Ready To Track button.
   In most cases, you see the following dialog. If you do not, skip to step 4.

   ![Warning dialog]

   **Problem:**
   The specified Device Aspect Ratio of 1.666 does not match up with the aspect ratio of the images which are 1.652.
   (Images on disk are 1.548 x Pixel Aspect Ratio of 1.087)
   If this is not corrected, you may encounter problems with the alignment of tracked points over the image.

   **Solutions:**
   1) Adjust Device Aspect from 1.666 to 1.652
   2) Adjust the Pixel Aspect Ratio from 1.083 to 1.08

3. Do one of the following:
   - Choose Solution 1 (Adjust Device Aspect) if you think your images were cropped. First, Live matches the Device Aspect Ratio to the value obtained from measuring your images on disk (Image Aspect Ratio x Pixel Aspect Ratio). Then, Live opens a second dialog with cropping options; see the next step.
2 | Setting up shots
How do I? > Set up image cache

- If you are sure your images were not cropped, choose Solution 2 (Adjust the Pixel Aspect Ratio). Live adjusts the pixel aspect ratio value to account for the difference between your images and the predefined filmback. You are now ready to track; skip the next step.

4 Choose Solution 1 (Crop the Width) or 2 (Expand the Height) from the second dialog.

This dialog appears if you choose to adjust the Device Aspect from the first dialog (Solution 1), because the same inconsistency exists in reverse order. In the first dialog, the device aspect ratio was based on the film aperture and didn’t match the image measurements. Now it is based on the image measurements and doesn’t match the film aperture. Solution 1 or 2 will adjust the camera aperture values to match the image measurements.

Solution 3 (Adjust Device Aspect) simply switches back to the first dialog.

Note When Live adjusts the aperture values, the Predefined Filmback switches to User because these are custom values.

Set up image cache

The Setup Cache control panel lets you allocate system memory for image storage and retrieval, showing you how many frames fit in that allocation. When you play through the sequence the first time, there is a delay while images load into memory, then it plays quickly. This feature benefits both the shotCamera and pointCenteredCamera views.
### To set up the image cache

1. Open the Setup Cache control panel in Maya Live.
2. Change the view panel to shotCamera by choosing Panels > Perspective > shotCamera.
3. Switch between the Pixel Type and Cache Size settings.
   You are trying to find which combination gives you the greatest storage of frames (shown in the Frame Capacity field) and the most acceptable image display. The first two settings—RGB and RGBA—store images in full color, while the last two settings—Indexed and Luminance—store images with reduced color.
   The image display does not affect the tracker itself, because it uses the full color information.
4. Experiment with the Texture Method setting.
   Play through the sequence to see which setting gives you the fastest playback. Texture Method controls which OpenGL method Live uses to draw images onto the image plane, as seen through the shotCamera and pointCenteredCamera views.
   SubImage gives the best performance on most SGI machines. On other platforms, the Image option can dramatically improve the speed of manipulating track boxes. If SubImage and Image make the performance worse, choose None.
5. Click Save Defaults if you want to permanently store these settings.

### To playback images

Play back your images in the shotCamera or pointCenteredCamera panel using the Time Slider tools. Keep in mind that the first time you play a sequence, performance is slow until the images load into memory. For faster speed while scrubbing, click the play button first, wait for the images to load into memory, and then you can scrub.
To get the desired scrubbing results, you may need to adjust the Playback Speed setting under Window > Settings/Preferences > Preferences, Timeline category.

When to disable image cache

Turn off the Use Cache option box if you:

- render, because the image plane will otherwise not appear
- use a movie file as a proxy
- use large, full resolution plate images without a proxy image (however, we recommend you use lower resolution proxy images in this case)
- encounter errors during playback or track box manipulation

Keep in mind that Live purges images in the cache if you turn off the Use Cache option or change the Pixel Type setting.

Note

Your images may disappear when you turn off the Use Cache. Move one frame forward or backward to refresh the image plane display.

Other Maya setup

In addition to the Setup control panel, review these other settings in Maya:

- **Required**: Set the correct time unit for the speed of the shot.
  
  You must set the time unit before you start tracking. To set the Time unit, Choose Window > Settings/Preferences > Preferences, Settings category.

- **Recommended**: Hide most of the interface items in order to maximize the Live workspace.
  
  You should keep at least the Time Slider, Range Slider, and Command Line. All other items can be turned off while working in Live. To do this quickly, choose Display > UI Elements > Hide UI Elements, then turn on the Time Slider, Range Slider, and Command Line from the Display > UI Elements menu.

- **Optional**: Set the Linear unit.
  
  The default is centimeters, but you may want to change it if you have survey data measured in a different unit. However, you can change the unit at any time. Choose Window > Settings/Preferences > Preferences, Settings category.
• **Optional**: Change the World Coordinate System from Y up axis (the default) to Z up axis.

We recommend using the default (Y up axis), but you can change it if needed. Make sure to change it before you solve. To change the up axis, choose Window > Settings/Preferences > Preferences, Settings category.

---

**Note**

- Working with Z up has the following consequences:
  - The shot camera looks down on the scene (negative Z). This orientation does not affect solutions, but you must rotate the camera to see it face forward.
  - Planes created for use with constraints (on the Solve Survey control panel) default to an X-Z orientation, which is perpendicular to the perspective view grid (X-Y). Rotate the plane if needed.

---

**Deinterlacing video shots**

Interlaced video shots are difficult to track, especially if the camera moves a lot or moves quickly. For best results, deinterlace your images before attempting to track the shot.

Since there are many ways to deinterlace images, the best two methods are described here.

**Interpolate scanlines on both fields**

The best way to deinterlace is to use a utility that separates the even and odd fields into an image per field, and then interpolates the empty scanlines using neighboring scanlines.

**On Windows**

Use any video editing or compositing tool that can separate the fields by interpolating the empty scanlines using neighboring scanlines.

**On IRIX and Linux**

Maya on IRIX and Linux includes a utility called `delace` for this type of deinterlacing. For example, to deinterlace a sequence of images called `sand.*.rgb`, type the following command in a shell:

```
    delace sand.rgb.0001 sand_fields.rgb.#
```
Before tracking, be sure to set the Time unit in Maya to the rate for fields (for example, 50 fields per second). Use the Window > Settings/Preferences > Preferences, Settings category. As you work, remember that you are working with separate fields, not frames.

**Delace options**

The IRIX and Linux delace utility also includes these option flags:

-s option

Specifies to use smoothing. With smoothing, the interpolation references neighboring frames as well as the scanlines. This option can improve results in sequences with slow camera movement, but it can cause undesirable artifacts in sequences with fast camera movement or fine detail.

-e option

Specifies that even scanlines in each image represent the first field in the frame. The result is an even scanline image followed by an odd scanline image. This flag is the default.

-o option

Specifies that the odd scanlines in the image represent the first field in the frame (the opposite of -e).

For example, to specify smoothing, type:

```
  delace -s sand.rgb.0001 sand_fields.rgb.#
```

**Interpolate scanlines on half of the fields**

The next best way to deinterlace is to use the `dmconvert` utility (available on IRIX and Linux only). The utility separates the even and odd fields, throws one of them away, and interpolates the empty scanlines using the neighboring scanlines.

For example, to deinterlace an NTSC video shot, type the following command as one line. Replace `in.*.rgb` with your source image name. If you are using PAL video, replace `inil=odd` with `inil=even`.

```
  dmconvert -v -f rgb -p video,inil=odd,il=none
  -n out.#####.rgb,start=1 in.*.rgb out.#####.rgb
```

Because `dmconvert` throws out the even or odd fields, you must set the Time unit in Maya Live to the frame rate (for example, 25 frames per second) instead of the field rate (for example, 50). Use the Window > Settings/Preferences > Preferences, Settings category. However, when you render, you will probably use the field rate.
The problem caused by solving at the frame rate is that the movement is interpolated for the missing field. The match should be close, but you might have some slippage on the fields which were discarded.

Create proxy images

If you have high resolution images (for example, greater than 1.5Mbytes per image), we recommend you create more manageable copies of your images, called proxy images. You can use lower resolution images, movie files, or luminance-only images for proxies.

Lower resolution

If you create lower-resolution proxies, make sure they have the exact same aspect ratio as the full resolution images. For example, if the full resolution image is 2048 x 1536 and the proxy image is half-size, the proxy image should have the dimensions 1024 x 768.

To scale full resolution images to proxies, use the dmconvert script (available on IRIX and Linux only). For example, to convert a 100-image sequence of D1 video resolution images (720x486) to half resolution (360x243), type the following command as one line:

```
dmconvert -f rgb -n full.rgb.####,start=1,end=100,step=1 -p video,size=360x243 full.rgb.#### half.rgb.####
```

where `full.rgb` and `half.rgb` represent the starting and resulting file names. Remember to change `end=100` to the number of images you are converting.

Luminance images

Black and white, luminance-only images can also serve as proxies.

You can convert images using the imgcvt command (available for IRIX and Linux and Windows) or by choosing the Luminance setting on the Setup Cache control panel. Both actions increase playback speed. The difference is when you want to wait for the images to convert. Using imgcvt, the conversion occurs on your hard disk once. Using the Setup Cache control panel, the conversion occurs in memory at run time and reoccurs each time your image cache is purged.

If you run the imgcvt utility, use the following example as a model:

```
imgcvt -r 1-341 sand.#.rgb sand.#.bw
```
2 | Setting up shots
How do I? > Luminance images
3 Shot strategy

About

Shot strategy
This quickest way to get a solution is to first plan your attack. Learn how to analyze your shot, choose good track points, and plan for constraints. Also included are suggestions for filming with match moving in mind.

Choosing good points
Always play back your shot and plan which points you should track. This step is critical in order to provide track points useful to the solver. You can use the Playblast or Time Slider to play the shot. For more information about playback tools, see “Live playback tools” on page 12.

What helps the solver:

- Choose features that are stationary or fixed on an object.
  To solve for camera movement, the track points must be stationary. To solve for object movement, the track points must be fixed relative to the moving object. For example, if you are tracking the movement of a car, a feature on a headlight would help, but not a feature on an antenna waving in the wind.

- Choose features that you can later constrain to a survey measurement.
  When you solve, you can get improved results using survey constraints, so choose features with constraints in mind. The survey constraints are: Plane (such as a floor, table, or wall), Point (a 3D coordinate, such as a point corresponding to a position on reference geometry), Distance (measurement between points), and Depth (distance from a point to the camera). For more information, see “Constraint strategies” on page 27.

- Choose features with long duration of visibility.
  The more frames the feature is visible, the better. For example, in a 100 frame shot, it should be visible for at least ten to twenty frames. Also, avoid features that come in and out of view too much.

- Choose features spread throughout the width, height, and depth of the scene.
  The solver needs a “balanced diet” of features from various areas, not just features grouped in one region.

- Choose features in the area where the 3D model will be in the scene.
In addition to tracking a variety of areas, you may want to track additional features around the intended 3D object location. If you intend to import the 3D model into the scene, look for points that clearly correspond to points on the model.

- Choose features that cover a range of motion.
  For example, if the shot is a slow pan from left to right, choose features in the center that overlap the start and end of the shot.

What helps the tracker

- Choose features with distinct shape or high contrast.
  To establish a lock on the target, the tracker uses both the object’s shape and contrast with the background. Tracking artificial markers is helpful, but natural features work as well, such as tree branches, rocks, and windows. An object that has a definable tip can be easier to track.

- Choose larger objects if possible.
  In general, tracking larger objects gives more accurate results than tracking small objects. However, a larger target means the tracker may fail sooner due to pattern changes.

- Avoid features that change shape radically.

- Avoid shifting backgrounds and highlights within the target area (inner box).

Example track points

The following illustration shows some of these principles. The points are stationary and spread throughout the breadth and depth of the scene. There is an emphasis on the fence because it is where the CG fence will be placed and because the flat geometry allows you to use a plane constraint.
Constraint strategies

As mentioned, you should plan on using Live’s survey constraints as part of your strategy. These constraints broaden the information supplied to the solver. (For complete details on the survey constraints, see “Choose survey constraints” on page 63.)

Survey constraints imply that you have site measurements, but that’s not always the case. The solver can still benefit from a limited number of constraints with your estimated values. (Try to limit estimated constraints to one or two of a given type, because too many estimates can make it impossible for the solver to find a solution.)

For example, you can add an estimated Distance constraint (measurement between points) to establish scale. Another common example is adding one or two Plane constraints to establish points as coplanar (such as a table or wall) or approximately coplanar (such as features on the ground).

Using infinite points

Another feature related to survey constraints are infinite points. When you designate a track point as infinite, the solver treats the point as infinitely far from the camera. Knowing a point is infinite, the solver can use it exclusively for calculating camera movement. Examples of features that you can designate as infinite include clouds, mountains, or any feature in the distant background. (For details, see “Choose survey constraints” on page 63.)
Survey constraints and camera movement

There is a temptation to equate survey constraints with particular types of camera moves. However, there is no direct correlation. They have a direct affect on the position of 3D locators, and this information does help the solver infer camera movement, but only indirectly.

However, on problematic shots with sparse or inaccurate data, constraints can make the difference that helps the solver succeed. See the next topic for a summary of the problematic shots and the constraints and other tips that can improve your results.

(Also note that Depth constraints are an exception; they directly affect camera movement by defining the distance from the camera to a point in the scene.)

Problematic shots

Certain types of shots are difficult to solve. In these situations, review this table to see how to obtain a good solution. Many of the tips involve constraints; for complete information see Chapter 5, “Solving.”
### Shot strategy

#### About > Problematic shots

<table>
<thead>
<tr>
<th>Shot Type</th>
<th>Difficulty</th>
<th>Tip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera rotation only (panning on a tripod)</td>
<td>Using track points alone does not provide enough information.</td>
<td>The camera translation constraint may be useful. (Live also has camera rotation constraints, but you can only constrain all three axis at once.) Change the Rotate Order to ZXY in the Attribute Editor, under the shotCamera node, Transform attributes. Also try adding survey constraints, especially Depth.</td>
</tr>
<tr>
<td>Truck or dolly with no camera rotation (moving down a hallway)</td>
<td>Features do not stay in frame long enough to provide useful tracking data</td>
<td>Choose features in the center that overlap the start and end of the shot. Also use ample survey constraints. In the hallway example, use plane constraints for the floor and walls.</td>
</tr>
<tr>
<td>Whip pan (quick movement)</td>
<td>Tracking information is not accurate enough.</td>
<td>If the whip pan affects minimal frames, you can fine-tune the camera manually. Increase root frames around areas of exaggerated movement.</td>
</tr>
<tr>
<td>Minimal camera movement</td>
<td>There’s not enough information for a camera solution.</td>
<td>If Live cannot solve for a camera, it may solve for object movement.</td>
</tr>
<tr>
<td>Few track points (desert, snow, or water scenes)</td>
<td>There are not enough track points to produce a solution.</td>
<td>Add survey and camera constraints to compensate for the lack of data.</td>
</tr>
<tr>
<td>Camera zoom</td>
<td>It is difficult to discern between zoom and camera movement.</td>
<td>Turn off the Static parameter on the Solve Camera control panel. Make two or more 3D points Infinite, using the Locator Summary panel, provided those points are visible long enough.</td>
</tr>
<tr>
<td>Very long shot (1000 frames or more)</td>
<td>Too many variables for the solver.</td>
<td>Track and solve for a segment of the shot, such frames 1-300. Once you have an initial success, you can then complete the rest of the scene.</td>
</tr>
</tbody>
</table>
Production tips

Here are some suggestions to follow while filming in order to make the match moving process efficient.

- If you use markers, use symmetric objects that produce little or no glare, such as tennis balls. Live can track many distinct, naturally-occurring features, so you may not need to add markers.
- Measuring survey data is almost always useful, but not a requirement. Emphasize survey data around the area where the CG element will appear.
- If you film with a zoom, find out the range of focal length values. The solver can calculate some focal length variance but you will get better results if you have the actual values.
- If you plan to have images scanned from a film source, find out whether the images are cropped so you can specify the cropped dimensions in the Setup control panel.
4 Tracking

About Tracking

In the Track task, you mark a variety of points within the images, such as the center of a flower or a mark on the fence, and have Maya track how they change position from frame to frame.

Related topics

- “Overall tracking workflow”
- “Track a point”
- “Evaluate a track point”
- “Correct track failure”
- “Filter track points for interlaced shots”
- “Review the Track Summary”
- “Determine when you’re ready to solve”
- “Use the Track Display panel”
- “Track Options panel”
- “Import track points”
- “Export track points”
- “Tracked point file format”

How do I? Track

Overall tracking workflow

The goal of tracking is to create points that follow the movement of key areas in the scene. With this tracking information, the solver can then analyze the shot and extract 3D locations and camera or object movement.

The general guidelines are:

- Review the shot and choose what to track.
  This step is so critical it has its own chapter. See Chapter 3, “Shot strategy.” In particular, read “Choosing good points” on page 25.
- Track the points you have chosen.
4 | Tracking
How do I? > Track a point

See “Track a point” on page 32 and “Correct track failure” on page 36 for instructions. Tracking a point is the same whether you are solving for camera movement or object movement.

- Determine if you are ready to solve.
  You don’t have to make tracking perfect before you solve. We recommend tracking and solving in passes. Track the basic points and get a rough solve, then add more track points to increase the solution’s accuracy. See “Determine when you’re ready to solve” on page 40.

- Solve and add more points, if needed.

---

**Note**
If you have a very long shot, such as 1000 frames, we recommend you first track and solve for a segment of the shot, such frames 1-300. Once you have an initial success, you can then complete the rest of the scene.

---

**Track a point**
Tracking a point is the same whether you are solving for camera movement or object movement.

---

**Note**
These instructions assume you are tracking a single point at a time, but you can apply the same steps to a group of selected points.

---

**To track any one point**

1. Open the Track control panel.
2. Move to the frame where you want to start tracking.
   You can track from the first frame forward, from the last frame backward, or from a middle frame in both directions.
3. Click the track box tool to activate the manipulation of track boxes:

4. Do one of the following:
   - Middle-click in the shot camera view over the feature. Live creates a track box in the area where you middle-click.
   - Create the track box first and drag it over the feature. You can create a track box by clicking the New button in the Track control panel or by choosing Track > Create Track Point.
5 Use the pointCenteredCamera view to position the track box more precisely.

Drag from the cross-hairs.

The track box moves opposite from your mouse because you are actually panning the camera.

6 Resize the track box target and search area, if needed.

When in doubt, however, keep the default size. For more information on how to size track boxes, see “Size track boxes” on page 34.

The inner target box defines the pattern to be matched.

The outer search area defines the area to search for the target.

7 Verify that Use Current Frame is checked, which specifies to start tracking from the current frame.

In general, we recommend that you always track from the current frame. If you want to track on a range of frames, however, you can enter the frame range values.

8 Change the Tracking Direction setting as needed: Forward, Backward, or Bidirectional.

For example, if you start from the last frame, choose Backward.

9 Click the Start Tracking button on the control panel.

10 Review the Pointblast movie that Live has created for you.

While reviewing, notice the last frame where the track box is on target and any frames where the track box slips or jitters. See “Evaluate a track point” on page 35 for details.
11 If the track fails or becomes obscured before the end, continue the track using one of the methods described in “Correct track failure” on page 36.

Size track boxes

For most objects, the default track box size is fine. However, in some cases, resizing is necessary to have a successful track. In fact, you may need to resize or reposition the track box a number of times to keep it on target. There are several factors you should keep in mind:

<table>
<thead>
<tr>
<th>Sizing Tip</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distinct pattern: The target size (inner box) should closely fit the boundary of the point, including some of the background to define its edge and make the target pattern distinct.</td>
<td><img src="image1.png" alt="Example Image" /></td>
</tr>
<tr>
<td>Target too small: If the target is too small, the track point may fail sooner because there is not enough background to distinguish it.</td>
<td><img src="image2.png" alt="Example Image" /></td>
</tr>
<tr>
<td>Target too large: If the target is too large, there are usually more changes in the pattern and so the track may fail sooner. (In this case, the shadow cast by the marker changes.) However, tracking larger objects generally gives more accurate results than tracking small objects. Just beware of including too much background.</td>
<td><img src="image3.png" alt="Example Image" /></td>
</tr>
<tr>
<td>Search too small: If the search area (outer box) is too small, the object you are tracking may fall out of the search area, especially with rapid, pronounced camera movement. This problem often manifests as an inexplicable drift off the target.</td>
<td><img src="image4.png" alt="Example Image" /></td>
</tr>
</tbody>
</table>
Evaluate a track point

The best way to check the accuracy of a track point is to play the track sequence from a point-centered view. By default, Live creates a Pointblast movie when it finishes tracking, but you can create it at any time by clicking Pointblast on the Track control panel. You can also use the pointCenteredCamera panel and scrub through the Time Slider, provided you have enough system memory allocated in the Setup Cache control panel.

When evaluating the movie, look for points that jump or drift. Generally, to get a fairly accurate solution, the track point cross-hair should not jump more than a pixel.

Do not rely too heavily on the Track Summary to evaluate track quality. Use it only as a general guide to problem areas in the track; it does not necessarily indicate the success of a track point. For more information, see “Review the Track Summary” on page 39.

Trace lines

You can also look at trace lines to evaluate the track. Trace lines appear as red and blue lines moving out from the track box. They depict the 2D movement of the track box from the current frame. The red line is backward and the blue line is forward. (For information on controlling the display of trace lines, see “Use the Track Display panel” on page 41.)

Use trace lines to evaluate smoothness of track movement and to verify that points in the same area follow a similar movement.

---

<table>
<thead>
<tr>
<th>Sizing Tip</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search too large: If the search area (outer box) is too large, the track point may jump to similar areas. Try reducing, lengthening, or widening the search area to avoid the similar objects. If in doubt, it’s generally better to enlarge the search area. A larger search area does impact performance, but not significantly.</td>
<td>![Example Image]</td>
</tr>
</tbody>
</table>
Correct track failure

Track failure means the tracker stops before the end or falls off the target. Failures are a natural result of the track pattern changing with camera movement. Although Live compensates for pattern changes, the quality typically drops off toward the end of the track. You can see this occurrence graphically in the Track Summary.

There are various approaches you can try to correct track failure. In general, keep in mind these important settings on the Track control panel:

**Tracking Direction**

You can try different directions as you track, either to overwrite bad tracking or to start from another frame. Forward and Backward are used most often, but Bidirectional is useful too. Bidirectional first tracks forward from the current frame, and then immediately tracks backward.

**Stop Tracking On**

This setting is useful to avoid overwriting valid tracking. By default, it is set to End Of Sequence, which overwrites all tracking. To stop on frames with higher quality, choose Better Frame. To stop on a frame you positioned yourself, choose User Tracked Frame.

**Corrective methods**

**Track from the opposite end**

With this method, the goal is to track from the opposite end until your track data meets in the middle with the beginning track data. For example, if you started forward, move to the last frame where the point is visible and track backward.

To avoid overwriting the valid track data, change Stop Tracking On to Better Frame or User Tracked Frame. Also, be careful to avoid jumps where the forward and backward tracking meet; you may need to reposition the tracker yourself.
Retrack in both directions
If the track quality dips in the middle, try choosing Bidirectional as the Tracking Direction. Bidirectional tracks both forward and backward from the selected frame. This method is also useful to continue tracking a feature that fails toward the end.

To avoid overwriting the valid track data, change Stop Tracking On to Better Frame or User Tracked Frame.

Resize the target or search box
The tracker can fail, drift off track, or jump to other objects if the target or search box are not sized properly. See “Size track boxes” on page 34 for guidelines on resizing. You may need to resize the target or search box on the failed frame or start over with a new size.

Be careful to keep the track box cross-hairs positioned over the same part of the feature as the original target.

Position the track box yourself
In some cases, you may save time by positioning the track box yourself. For example, if the object you are tracking becomes blurry and then clear again, try positioning it yourself on the blurred frames and then restart tracking when it is clear. Remember to click the track box tool to enable manipulation of the track box. Also note that the Track Summary draws a blue line to indicate you have positioned the track box on a given frame.

Adjust Track Options settings
If the previous techniques do not help, see “Track Options panel” on page 42 for other settings that may improve tracking.

Delete frames from track data
You should delete the tracking data if the feature falls out of view or is poorly tracked. For example, the feature may become obstructed by another object or move out of the camera’s view.

Delete the frames even if they are in the middle of the tracking. If you don’t, these problems will negatively affect your solution.
To delete tracking data frames

1. Zoom in on the affected point’s tracking data in the Track Summary. Press Ctrl+Alt and drag the mouse around a zoom region. Drag from left to right.
2. Select the problem frames in the Track Summary.
3. Choose Edit > Delete Region from the Track Summary pull-down menu or the right-click pop-up menu.

Delete and deactivate track points

You can permanently delete track points or temporarily deactivate them. To delete them, use the Delete key, the Edit > Delete option, or the Delete button on the Track control panel. To deactivate them, turn off the Active checkbox on the Track control panel.

Deleting a track point removes affiliated 3D locators from all solutions. If the point is used in any survey constraints, Live forces those constraints to be inactive. In this case, you need to recreate the constraint.

Note: If you delete a track point and then choose Edit > Undo, you may need to repeat the Undo command to reverse the deletion of an affiliated 3D locator.

Filter track points for interlaced shots

You can use a Filter command to smooth out tracking discrepancies in the Y motion curve. These discrepancies are primarily caused from tracking an interlaced video shot. Live has a low pass filter, meaning it only smooths high-frequency changes.

To filter a track point

1. Select one or more track points.
2. Choose Track > Filter.
   The filter applies to the whole track point, not a selected region.
Review the Track Summary

The Track Summary panel graphically depicts track point quality across time. Use it to:

- review your overall work progress
- identify problem areas for a given track point
- delete frames from track data (see “Delete frames from track data” on page 37 for details)

**Track quality**

Indicates the success of each point’s tracking over all tracked frames. Track quality is conveyed with the following colors:

- Green is good; all green is a perfect match between the original target and the subsequent frame
- Yellow is a warning
- Red is strong warning; all red means the tracker surpassed the Failure Threshold. Failure Threshold, on the Track Options control panel, controls the amount of difference the tracker permits between the original target and the subsequent frames.
- Blue lines are frames where you positioned the track box yourself

The quality is determined by calculating the average pixel difference between the starting target and each frame thereafter. When the feature changes shape or size, quality starts out green and diminishes as the point changes pattern.

**Note**

Use the color indicators as a guideline only. You must evaluate the Pointblast of the track point to be certain of the track point’s quality.
Per-point solvability

Indicates the point’s contribution to the scene’s solvability. To compute this indicator, Live evaluates the range of camera or object movement for all the frames where that point is tracked. The more angular measurements Live can obtain from the tracked point, the more the point contributes to the scene’s solvability, and so the more green it appears.

Navigation commands

Use the following Track Summary commands for navigation. They are under the View menu and the right-click pop-up menu.

Frame All

Changes the view to includes all points and all frames.

Jump To Start

Jumps to the first frame in the selected range.

Jump To End

Jumps to the last frame in the selected range.

Update During Drag

When this option is on, the other view panels update as you drag a selection of frames in the Track Summary. When it is off, the other view panels only update when you change frames.

Determine when you’re ready to solve

You don’t have to make tracking perfect before you solve. We recommend tracking and solving in passes. Track the basic points and get a rough solve, then add more track points to increase the solution’s accuracy.

Use the Track Summary panel to help determine if you’re ready to solve. Look for the following:

- Number of track points over time: You need a good coverage throughout the shot. See “Number of track points” for more information.
- Ready To Solve bar and per point solvability: These indicators should be mostly green.
- Errors in tracking: You can still solve if there is some red in the tracking data, but play any red regions to make sure the track box is on target. Delete any regions where the track box is off target and cannot be corrected.
Number of track points

The optimal number of track points depends on several factors. Here are some guidelines:

- Generally, a rough solution (1-2 pixel slippage) is possible with 5 to 10 well-tracked points visible at any given time.
- Because some points drop out of visibility, you may need more than 10 points overall. Longer shots usually require more points.
- Shots with minimal camera movement need more points than shots with lots of camera movement.
- By providing survey constraints, such as the depth from the camera or the distance between points, you can typically reduce the number of points needed.
- The more accuracy you require in the solution, the more well-tracked points you should add. However, adding more than 40 points would probably diminish the benefit.

Use the Track Display panel

The Track Display control panel lets you:

- display the names of each track point in any of the views
- display the names of each 3D locator in any of the views
- see a trace line for the movement of a tracked point, showing both the forward and backward movement from any given frame

To turn on or off any of the track point display features, open the Display control panel under the Track task. For each display feature, you can choose how it will display: Always, Selected (when a track point is selected), or Never.

To control the length of trace lines, use the Length Forward and Length Backward fields.
Display colors
You can also specify the colors for tracked points and other display features. Double-click the color box to open the Maya Color Chooser. You can specify both an Inactive color (item not selected) and an Active color (item selected). The display features are:

Track Point
Colors used for track points and their labels at all times except in an error state.

Error
Colors used when a track point is in an error state, such as a poor tracking.

Trace Line
Colors used for trace lines, one for the backward line and one for the forward line.

3D Locator
Colors used for the 3D locators created by Live.

Constraint
Colors used for the objects and lines representing constraints.

Track Options panel
The Track Options control panel includes various settings that affect tracking. You may want to experiment with these options if you are having problems tracking.

Point List
Displays the list of tracked points.

Select All
Automatically selects all track points in the list.

Select None
Automatically deselects all track points in the list.

Global Illumination
When set to Corrected, Live automatically corrects for changes in global illumination. For example, if a shadow or light glare appears for some of the frames, the tracker compensates for the change in lighting. When set to Not Corrected, Live does not correct for changes in luminance. Set Not Corrected if you want the tracker to use a more exact pattern match.
4 | Tracking
How do I? > Track Options panel

Color Space

Allows you to choose between Full and Reduced color space. Full uses the full color table that correlates to the original image. Reduced uses a reduced color table when matching to the original image. Full helps the tracker distinguish between features with similar shape but different colors. Reduced helps the tracker with subtle features, such as dark green leaves over dark brown ground.

| Note | The Reduced setting may cause errors if you are using images with one color channel removed, such as the blue channel. In this case, use the Full setting. |

Blur Radius

By default, the tracker blurs images to compensate for interference, or noise, such as filmgrain. You don’t actually see the blur (it is done in memory only), but it helps the tracker stay on target. You can control the amount of blur by adjusting the Blur Radius. For example, if you are tracking a subtle feature, the default amount of blur may be too much. A value of zero disables the blur.

Use Rotate, Use Scale

The target box automatically adjusts in shape to compensate for rotation or scale changes in the target image. This feature helps with the most common reason for tracking failures: shape changes in the feature you are tracking. Adjust the Use Rotate and Use Scale settings to control the amount of rotation or scale. If you find the tracker is falling off target, adjusting the value for these settings may help.

Subpixel Precision

Allows you to define a resolution for subpixel tracking. Smaller values take longer, but might be more accurate.
**Update Behavior**

Controls the way the tracker updates the target pattern as it changes.

**None**

The tracker keeps the initial pattern it snapped and does not update it.

**Incremental**

The tracker takes a new snap of the target after a specified number of frames. It is specified in the Update Increment setting.

**Smart**

The tracker takes a new snap of the target only when it differs from the original target by a given threshold amount. The threshold is specified in the Update Threshold setting.

**Update Threshold**

Allows you to specify a threshold for determining when the track pattern updates. The Update Behavior must be Smart.

**Update Increment**

Allows you to specify the number of frames for determining when the track pattern updates. The Update Behavior must be Incremental.

**Failure Behavior**

Controls what the tracker does when it fails to find a pattern match.

**Stop**

The tracker stops on failure.

**Ignore**

The tracker continues looking for the closest match.

**Predict**

The tracker continues to track by estimating the motion curve of the track point.

**Failure Threshold**

Controls the amount of difference the tracker permits between the original target and the subsequent frames. When the tracker cannot find a match within the threshold, the track fails.

**Show Progress Image**

Determines whether or not to display a progress image during tracking.

**Image Buffer Factor**

Controls the buffer size, in pixels, that Live adds around the search region when it creates a Pointblast movie. For example, if the search region size is 50 x 60 pixels, and the factor is 1.5, the movie display is 75 x 90 pixels.
Image Zoom Factor
Indicates the magnification of the progress image

Make Movie
Determines whether or not to create and display a Pointblast movie
when the tracker finishes.

Import track points
If the shot was tracked previously, you can load the tracked data,
provided it follows a specific format. See "Tracked point file format" on
page 45 for details.

To load the tracked point file
1 Choose Track > Import Track Points.
2 Select the track points file in the Open window.
3 Click the Open button to load the selected file.

Export track points
Exporting track points is intended for situations when you need to start
over with a new scene, but you want to use the track data you already
created. For example, to use a version 1.5 file in Maya Live 2.0, you must
export the track points and import them into a new scene.

To export tracked points into a file
1 Choose Track > Export Track Points.
The Export browse window opens.
2 Browse to a directory and enter the tracked point file name.

Tracked point file format
The tracked point file must follow a specific format:

# Size [image width] [image height] [device aspect]
# Pixels
# Name [pointname] [pointnumber] [framenumber] [xlocation] [ylocation] [error]
# Size

If you are specifying coordinates in pixels, the first line must specify
the image size in pixels. The device aspect is optional.

Device aspect = (image width/heigth) * pixel aspect ratio
# Pixels
If you are specifying coordinates in pixels, this must be the second line.

# Name
The first line of each point specifies its name.

pointnumber
The point number in this file. It should increment for each point.

framenumber
When you import points, Live adds this number to the Start Frame number to compute the frame number. Start Frame is specified in the Setup control panel.

xlocation, ylocation
Location in pixel coordinates or normalized coordinates.

If you use pixel coordinates, the X coordinate varies from 0 to the image width. The Y coordinate varies from 0 to the image height. The point 0, 0 is the bottom left of the image.

If you use normalized coordinates, the X coordinate varies from -a (left) to +a (right) where a = (image width/height) * pixel aspect ratio. The Y coordinate varies from -1 (bottom) to +1 (top).

error
This is an optional value measuring the tracking error. It ranges from 0 (a perfect match) to 1 (no match).

Example tracked point file

# Size 720 486
# Name left1
0 0 -0.7585931914 -0.5294952326 0
0 1 -0.7586799904 -0.5300096425 0.002832949162
0 2 -0.7585931849 -0.5313921014 0.01325005293
0 3 -0.7580434163 -0.5337390664 0.004410386086
0 4 -0.757522583 -0.5358931302 0.01897031069
0 5 -0.7574936478 -0.5389473998 0.01043349504
0 6 -0.7574936478 -0.5436413298 0.01106923819
0 7 -0.757204296 -0.550392873 0.01106923819
0 8 -0.7565966571 -0.5589769779 0.01841163635
0 9 -0.7534427219 -0.570551052 0.01649397612
0 10 -0.7526325367 -0.5828002804 0.01214426756
# Name left2
1 0 -0.7549460687 -0.085601414 0
1 1 -0.7552932739 -0.08663023646 0.005688428879
4 | Tracking

How do I? > Example tracked point file

```plaintext
1 2 -0.7553800795 -0.0879483949 0.01128107309
1 3 -0.7542226721 -0.0900730848 0.005126774311
1 4 -0.7536439684 -0.09244942371 0.01110613346
1 5 -0.7534414221 -0.09543939284 0.01303964853
1 6 -0.7532967461 -0.1000047221 0.01685106754
1 7 -0.7530073943 -0.1064990636 0.01059484482
1 8 -0.7522840147 -0.1151796192 0.007831633091
1 9 -0.7516474406 -0.1260463887 0.006545543671
1 10 -0.7499402647 -0.1374597118 0.013938069343
# Name left3
2 0 -0.7504397714 0.2400678146 0
2 1 -0.7506134033 0.2385246371 0.01199233532
2 2 -0.7506134033 0.2374315301 0.01194387674
2 3 -0.749629607 0.2357918696 0.004064679146
2 4 -0.7487615515 0.2332520034 0.01138979197
2 5 -0.7486168755 0.2304227853 0.01261204481
2 6 -0.7484432644 0.2258896062 0.0166606307
2 7 -0.7481828478 0.2194917153 0.007826387882
2 8 -0.7475173385 0.211004061 0.004957020283
2 9 -0.7460416441 0.1997836392 0.007061779499
2 10 -0.7449131718 0.1893348223 0.0135897994
```

Live

47
4 | Tracking
How do I? > Example tracked point file
Solving

In the Solve task, you run a solver program that computes an animated camera, based on the movement of the track points.

When your tracked points are ready, it’s time to solve. The solve process does the following:

- creates 3D locators for the points you tracked
- calculates the camera movement around the locators or the movement of the locators around the camera (you can toggle between the two types of movement)
- adjusts camera focal length, depending on the camera constraints (see "Create a focal length constraint" on page 69 for a full discussion)

Live’s solver operates in distinct steps, which you can run separately or in one automatic process. The solver bases its solution on root frames, which are important frames it chooses from the shot (although you can select the root frames yourself).

Related topics
- “Overall solve workflow”
- “Run the solver”
- “How the solver computes a solution”
- “How the solver computes a solution”
- “Evaluate a solution”
- “Review the Locator Summary”
- “Improve solutions”
- “Choose survey constraints”
- “Create and modify survey constraints”
- “Create infinite and locked points”
- “Create a focal length constraint”
- “Create camera translation and rotation constraints”
- “Render a solution”
- “Export a solution”
How do I? Solve

Overall solve workflow

Getting a solution is an iterative process. The same workflow applies whether solving for camera movement or object movement. The main steps are:

- Run the solver. For instructions, see “Run the solver” on page 51.
- Evaluate the solution: See “Evaluate a solution” on page 55.
- Make improvements: The remainder of this chapter discusses ways to improve a solution. For an overview, start by reading “Improve solutions” on page 59.
- Solve again: As you make improvements, run the solver again to see the results.

When you are finished, you can export the solution camera and 3D locators. This feature is useful for sharing with users that are not licensed for Live or who are using Discreet software.

Reference geometry workflow

If you have reference geometry for the scene, you may want to create point constraints for those features before you solve. Use Maya snap tools to snap the geometry to the point constraints.

Another workflow is to solve and then use the lock setting in the Locator Summary panel. For more information, see “Choose survey constraints” on page 63.

Use the Solve control panels

The Solve control panel is where you execute the solve process. It also includes a solution list to help you manage your work. Every solution result is listed so you can move between them and compare results.

The following illustration summarizes the main areas of the Solve control panel.
Run the solver

You can run the solver automatically or in several interactive steps. Both methods use the same algorithm, but you have more control running in interactive steps.

- One automatic process: This is the simplest method, because the solver runs through all steps at once.
- Interactive steps: With this method, you control which step to run and you may repeat steps to see the outcome of improvements you make.

To run the solver in one automatic process

1. Open the Solve control panel.
2. Verify the frame range is correct; change it if needed.
3. Click the Solve button under the Root Frame heading.
   When the solution is complete, it appears in the solution list named `solution_rf`.
4. Click the As Object checkbox if you want to switch the solution to object movement around a fixed camera.
5. Evaluate the solution to look for problems (see ”Evaluate a solution” on page 55).
6. If you find problems, you can run the solver again, but you can probably save time running the solver in steps.

Note Whenever you want the solver to produce a brand new guess, select `initial1` before you restart the solver.

To run the solver in interactive steps

Follow these guidelines:
Follow the general order: Start, Continue (if you want Start to run longer), Refine, Finish, and Register (if you add or change survey constraints). For details on each step, see "Root Frame step descriptions" on page 52.

Between each step, evaluate the solution and make any needed improvements.

Repeat steps as needed to incorporate changes.

Click Register at any time to see the effect of survey constraints on your solution as a whole.

Keep notes on the changes you made before running each step. Because you typically repeat steps, knowing what you tried, such as adding points or constraints, will help you isolate problems later.

Make sure the last solution is selected before running the next step. The solver uses the selected solution as a starting point. For example, select guess# (where # is the number of the guess) before clicking Refine.

Root Frame step descriptions
Use this table if you are not sure what step to run.

<table>
<thead>
<tr>
<th>Step</th>
<th>Purpose</th>
<th>When to Run</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Creates an initial guess.</td>
<td>At the beginning and whenever you need a new guess. Make improvements and repeat until you get a close solution.</td>
</tr>
<tr>
<td>Continue</td>
<td>Optional step that continues guessing where Start left off.</td>
<td>Immediately after Start, if you want the solver to consider other possibilities.</td>
</tr>
<tr>
<td>Refine</td>
<td>Recommended step that improves the best guess.</td>
<td>When you want to refine a close guess. Make improvements and repeat until you get an accurate solution.</td>
</tr>
<tr>
<td>Finish</td>
<td>Required step that applies the solution to all frames.</td>
<td>Once, when you get an accurate refined solution.</td>
</tr>
</tbody>
</table>
How the solver computes a solution

Read this section if you’re curious how the solver does its work and want a better understanding of each step in the solve: Start, Continue, Refine, and Finish. (A good time to read this is while you’re waiting for the solver to compute.)

In general, the solver treats match moving as numerous equations and variables. Each 2D track point on each frame sets up two equations (for X and Y) and three variables (X, Y, Z). Plus, there are numerous variables for the camera movement, variables for focal length, and more equations if you use constraints.

To complete the equations, the solver uses mathematical analysis to find the set of values that best satisfies the unknown variables. There is usually no unique solution because there are more equations than variables.

If the solver performed this process on every frame, the number of equations and variables would be enormous. To make the process more manageable and accurate, the solver reduces the number of frames to carefully chosen root frames. Once the root frames are solved, the solver then extrapolates the solution for all other frames.

When choosing root frames, the solver tries to represent the motion of the camera so that there are more root frames when the camera is moving and fewer when it is not. The root frame selection process involves totalling the movement of track points, which implies the amount of camera movement.

Measuring success

The solver measures the success of the mathematical analysis by checking how well the 3D points align with 2D track positions, as viewed through the virtual camera. The solver reports the average pixel difference between 2D and 3D points in the Overall Pixel Slip field on the Solve control panel.
Start and Continue

During the Start phase, the solver creates three guesses for each root frame by projecting track points onto planes placed at different angles. The solver then optimizes each guess. Optimization is a mathematical approach for finding a set of values that most closely satisfies the unknown variables in the equations. (It’s a sophisticated method of trial and error.) Optimization continues until the solver converges on an initial solution. Converging means the solver has found a close solution or detects a failure to progress. Either way, it passes its best solution on to the Refine step.

If the solver cannot converge based on the initial guesses, it creates more guesses, and if they fail to converge, the Start phase eventually stops. However, you can tell the solver to create more guesses by clicking Continue.

Refine

In this step, the solver further optimizes the converged solution to make sure it is as accurate as possible. This process is done in preparation for the Finish step, when the solution is extrapolated from root frames to all frames.

Finish

After the Start and Refine steps, you should have a reasonably accurate solution, but it is only solved on the root frames. The solver must then extrapolate the solution for all other frames. It does this by solving and optimizing the same equations at each frame using the root frame solution as an initial guess. This process continues until all frames have optimized values for the equations, resulting in 3D locators and camera positions for all frames.

Smoothing and Filtering

As part of the Finish step, the solver also performs smoothing and filtering. These processes address potential camera motion problems that are inherent with solving on just root frames. With root frames, the solver can only consider track points in isolation, without considering the position of the camera on adjacent frames. This situation can create unwanted roughness and noise in the camera motion.

The first process, smoothing, corrects for shifts in the camera’s motion curves caused by track points appearing or disappearing within the camera’s view. If a point’s visibility changes between root frames, the solver can’t factor it in until the Finish step, which causes a discontinuity. Smoothing counteracts this effect by adjusting the curve before and after
the frames where track point visibility changes. You can control the extent of smoothing in the Smoothing Interval setting on the Solve control panel. For more information, see “Adjust the Smoothing Interval” on page 61.

Filtering corrects for unwanted jitter in your camera move solution. Jitter can occur around frames where the solution to the solver’s equations is mathematically ambiguous or uncertain. The root frame solve process tends to amplify these ambiguities, creating jitter in the camera’s motion. Filtering finds the frames with ambiguous equations and applies a strong filter to those areas in the camera curves. You can control the amount of filtering in the Filter Level control on the Solve control panel. For more information, see “Adjust the Filter Level” on page 61.

Registration

If you only use track points, the solver cannot compute the absolute size of a scene or how it’s oriented. The scene could be a house or a doll house and could be tilted on it’s side or facing upright; the solver wouldn’t know.

To resolve these ambiguities, the solver takes your survey constraints and runs a registration process. Registration means orienting the entire solution as a whole without changing the structure. As a result, the camera and 3D points appear shifted or scaled within the perspective view, but when viewed from the camera, the 3D points appear in the same place.

Registration occurs as part of the Start and Refine steps by introducing more equations to be optimized. There is also a separate Registration step. This step lets you iteratively add survey constraints and see the results on the whole solution. It also lets you process Registration only constraints (see “Using Registration only” on page 65).

Summary

All of the input you give the solver becomes equations and variables. The solver’s task is to “hunt” for a set of values for the variables that best satisfies the equations. Most of the hunting occurs in the Start step and, optionally, the Continue step. The other steps are intended to make a close solution more accurate.

Evaluate a solution

Typically, the solver first produces rough solutions and then more and more refined solutions as you make improvements.

To evaluate a rough solution

1 Start by noting the Overall Pixel Slip on the Solve control panel.
To determine the success of a solution, the solver calculates pixel slip, which is the distance in pixels between the track point and its locator. The average pixel slip for all points on all frames appears in the Overall Pixel Slip field.

To see the average pixel slip for any given frame, refer to the Frame Pixel Slip field. This value is useful if you suspect certain frames have problems.

**Note** Adding track points and survey constraints may increase the Overall Pixel Slip by a small amount.

2 Look in the perspective view to check relative 3D locator placement and camera or object movement.

Locator positions should have the right shape relative to each other and the camera movement. Scale and orientation to the world grid do not necessarily matter. Later, you can scale and register the solution to the grid using survey constraints.

3 Examine the solution curves in the Graph Editor panel.

Look for unusual, unrealistic changes in the curves and dramatic differences in the range of values.
4 Check the Locator Summary panel for 3D locators with mostly yellow or red in the quality graph. (For details on reading this panel, see “Review the Locator Summary” on page 58.)

5 For points with low locator quality, look in the shot camera view to check alignment of track points with 3D locators.

Check only root frames; the other frames may not match. (However, solutions generated by Solve and Finish do apply to all frames.)

To evaluate a refined solution

Once you have a close solution, you should look for any jumps or jitter. Use the following steps. Also repeat the same steps for evaluating a rough solution, if needed.

1 Try importing or creating a 3D object in the scene to use as a reference.
   To import, choose File > Import. To create an object, use one of the primitive geometry tools on the shelf.

2 Play a movie of the solution with any of the following methods:
   • Click the Playblast button on the Solve control panel to open a movie player window.
5 | Solving
How do I? > Review the Locator Summary

- Use the playback buttons at the bottom of the Maya window, provided you have set aside enough memory cache in the Setup control panel. See “Set up image cache” on page 18 for more information.
- For the best, most accurate evaluation of a solution, render a sequence of frames, composite the images and their matte information, and then record it onto Zap!iT or another digital disk recorder.

Review the Locator Summary

The Solve task layout includes a Locator Summary panel. This panel graphs locator and frame slip quality. By default, it appears in the bottom left panel when you choose the Solve task.

Use the Locator Summary panel to evaluate how closely the 3D locators created by the solver match with the 2D track points. Also use it to make points infinite or locked. See “Create infinite and locked points” on page 68 for more information.

Locator quality

Graphically indicates the amount of pixel slip between each locator and its corresponding track point. Pixel slip is the distance in pixels between the track point and it’s locator. Like the Track Summary, green is good quality, yellow is a warning, and red is a strong warning.

Frame Slip

Graphs the average pixel slip for all locators on each frame. (Pixel slip is the distance in pixels between the track point and it’s locator.) This graph corresponds to the Frame Slip field on the Solve control panel. Use it to locate areas where the quality drops.
Improve solutions

This section presents an overview of the ways you can improve solutions. The suggestions are presented in order of the most common problem areas.

Add or improve track points

Track points should be the first area you try to improve. First, look for jumps or obstructions in the tracking and retrack those areas. Then, look for areas in the sequence that require more track points and add them.

Remove bad track data

Bad track data can be as problematic as too little track data. Make sure to delete all frames where a track point is obscured or falls out of the camera’s view (Edit > Delete Region).

Other options include:

- Making a track point inactive: In some cases, you may want to temporarily remove the track point to see if it helps the solver. You can do this by turning off the Active checkbox on the Track control panel.
- Decreasing the track point’s weight: The Variance setting on the Track control panel lets you change the weight the solvers attribute to a track point. By default, the solvers weigh track points according to their tracking quality. If you want to decrease the track point’s weight, use higher variance values, such as five to ten. (This field has little effect toward increasing the track point’s weight.)

Add constraints

The solver can consider additional information in the form of constraints. There are two types: survey and camera.

Survey constraints help define spatial relations, especially in areas where track point data is minimal. For example, if part of your shot has only three track points visible, but they are coplanar, you can add a Plane constraint. See “Choose survey constraints” on page 63.

Camera constraints control camera focal length, translation, and rotation. The focal length constraint is used more often (see “Create a focal length constraint” on page 69). The camera translation constraint is useful for shots where the camera remains on a tripod. Camera rotation is occasionally used, but it can only constrain all three axis at once. More often, you can improve camera translation and rotation through survey constraints. For details, see “Create camera translation and rotation constraints” on page 72.
Locked points

Another constraint feature, called locked point, is available in the Locator Summary panel. Locked points are the same as Point constraints, but they are easier to create. They are primarily used to snap 3D locators to points of geometry. See “Choose survey constraints” on page 63.

Infinite points

The Locator Summary panel also lets you specify points as infinitely far from the camera so the solver can use it exclusively for calculating camera movement. This feature is especially helpful for zoom shots. See “Choose survey constraints” on page 63.

Eliminate inconsistent constraints

If you add multiple survey constraints, be careful that they do not conflict with each other. Live weighs constraints together and makes compromises if they conflict. For example, if a point were constrained at 0,0,0 and also constrained to a plane at X=2, the solver would choose half-way between the origin and the plane (X=1). If you detect this kind of problem in your solution, look for conflicting constraints.

Adjust the number of root frames

The default number of root frames chosen by the solver may not be enough for your shot, especially if the track points in your shot move quickly out of frame. Change the value in the Number of Root Frames setting to a greater number (typically, 10 or 15).

Modify the choices for root frames

In general, the solver picks good, representative frames, but you may want to try choosing your own. Live lets you add or remove root frames in the Solve Solution control panel. The next time you run the solver, it uses your list of root frames rather than choosing its own root frames.
Choose frames that help depict the camera movement, but be careful to avoid frames that have poor tracking. For example, if the camera moves slow and then speeds up for ten frames, add root frames where it speeds up. However, if the camera moves too quickly, such as a whip pan, the tracking may be too poor and you should avoid those frames.

**To specify a root frame**

1. Open the Solve Solution control panel.
2. Turn on the Use User Specified Root Frames checkbox.
3. Type the desired frame number in the Frame Number setting.
4. Click Add.

**Adjust the Smoothing Interval**

The Finish step performs smoothing on camera motion curves around frames where track points appear or disappear. You can control the extent of smoothing in the Smoothing Interval setting on the Solve control panel.

Sometimes the smoothing might not be enough. If you detect bad transition in the camera movement, try doubling or tripling the value in Smoothing Interval and then running Finish again. The more smoothing you add, however, the more pixel slip you introduce between the 3D locators and track points.

Smoothing only applies to camera movement and only around frames where track points appear or disappear. The appearance or disappearance of track points can cause sudden shifts in the camera's motion curves, because the points are suddenly taken in or out of the calculation. Smoothing counteracts this effect by adjusting the curve before and after frames where track points appear or disappear. Smoothing Interval is the number of frames to smooth before and after.

**Adjust the Filter Level**

To correct for unwanted jitter in your camera move solution, the solver performs a filter during the Finish step. You can control the amount of filtering with the Filter Level control on the Solve control panel.

This filter specifically corrects the jitter that can occur around frames where the solution is mathematically ambiguous or uncertain. The root frame solve process tends to amplify these ambiguities, creating jitter in the camera’s motion. Filtering finds the frames with ambiguities and applies a strong filter to those areas in the camera curves.

Adjust the Filter Level if you want more filtering or if the precision of the solution suffers as a result of too much filtering. A value around ten is the upper limit, while zero disables the filter.
5 | Solving
How do I? > Move the camera into an approximate starting position

Move the camera into an approximate starting position

If the Root Frame Start produces incorrect guesses, you may be able to help it by positioning the camera into an approximate starting position. You may also try positioning the camera on both the first and last frames. The camera does not have to be accurate, just roughly where you expect it to be.

This method is particularly useful if you have created survey constraints prior to running Start, because the constraints may be interfering with the solver’s guess. If this is the case, you may also try making the constraints inactive or Registration only until you reach the Refine step.

Fine tune the camera

For minor adjustments to the camera position, you can try using the tools on the Fine Tune control panel. You make these adjustments per frame. Make sure, however, you have checked the track point accuracy first, because that will often remove problems with camera jitter or jump.

Change the camera rotation order

For panning shots on a tripod, you can get improved results by changing the Rotate Order attribute of the shot camera to ZXY. You can find the Rotate Order attribute in the Attribute Editor, under the shotCamera node, Transform attributes.
Choose survey constraints

This section guides you through the different types of constraints to illustrate how they can improve your solution. Be careful which ones you choose, because it could have a detrimental effect on the solution if you create a poor or conflicting constraint.

Survey constraints have two purposes:

- Register a solution. The most frequent use of survey constraints is to register the *whole* solution within the Maya world coordinate system. Registration does not affect the shape or movement of the solution, only its placement and scale. For example, if your solution lies under the world grid, you can create constraints that place the whole solution above the grid.

- Help the solver find a solution. Survey constraints can also give the solver information it needs to find a solution. For example, if part of your shot has only three track points visible, you help define their location using Plane or Point constraints.

Point constraints

Point constraints provide explicit control over a point’s coordinates. A single point constraint will translate the computed solution to the specified point, for example, the origin. Two point constraints translate and scale the solution. Three constraints explicitly lock the solution to a translation, scale, and rotation. (You should have accurate measurements from the set if you specify three or more point constraints.)

Live also includes a similar feature, called locked points, that can be easier to use than point constraints. For more information, see "Create infinite and locked points" on page 68.

Distance constraints

Distance constraints scale the solution to fit a given distance between two points. They are mainly used to set an appropriate scale when the locators are too condensed or too spread out. Be careful of adding too many distance constraints because it is difficult for the solver to satisfy all of them.

**Tip:** If you specify large distance values (for example, 50 cm), the grid size and locators may appear too small. To compensate, scale them up. To scale the grid, use Display > Grid. To scale the locators, select them all and change the scale values in the channel box.
5 Solving
How do I? > Plane constraints

Plane constraints

Use plane constraints to constrain points to a wall, floor, table, ground or other flat surface.

Constraining to a line

You can constrain points to a line by creating two plane constraints that intersect. In the following example, two planes constrain points to the Z axis. Notice some locators are slightly off the line due to variation in the areas tracked.

Approximate planes

Plane constraints try to make points perfectly coplanar. If they are only approximately planar, such as uneven ground, try specifying the plane constraint as Registration only. For details, see “Using Registration only” on page 65.
Depth constraints

Depth constraints define the distance from a given point directly to the camera lens for a given frame. Their primary purpose is to help solve tripod shots with camera rotation only. In these shots, the solver cannot determine depth of points, so additional information is needed.

You probably need to add several depth constraints when you use them. Set up constraints for all important points in the first frame. You may also need them for the points in the last frame, especially if the points from the first frame fall out of view.

Using Registration only

By default, the solver uses constraints to calculate the solution’s shape. In some cases, however, you may want to use the constraint only for registration of the scene as a whole. To do this, click the Registration only checkbox in the Survey control panel.

Registration only is mainly used for plane constraints on a ground or other surface that is roughly, not exactly, coplanar. Without Registration only, the solver would try to force the points to be coplanar, which may not match reality.

Create and modify survey constraints

This section describes the steps needed to create or modify survey constraints.
General guidelines

- You can create survey constraints at any time, provided you have track points. However, we recommend first obtaining a proximate solution before adding constraints.
- The number of survey constraints varies depending on which constraints are appropriate for the shot. Typically, shots require no more than seven to eight constraints, but there are no limits to how many you can add.
- It’s okay to estimate constraint distances or coordinates if you are using a limited number of constraints. (There is also a Variance setting you can use to allow the solver some leeway.) However, we recommend using accurate measurements from the set if you create multiple constraints.
- Where you place survey constraints is important. Refer to “Placement of Plane and Point constraints” on page 68 for more information.
- Adding constraints slows performance of the solver, but there is less of an impact for Registration only constraints.
- You can adjust the colors used for the objects that represent constraints. See “Use the Track Display panel” on page 41.

To create survey constraints

1. Open the Solve Survey control panel.
2. Select track points as you would any Maya object. (Do not select the associated 3D locators—only track points.)
   Typically, you select in the shotCamera panel or through the Outliner (listed under clip1TrackedPointVisibilityGroup > clip1TrackedPointGroup).
3. Choose the constraint you want from the LiveConstraints pull-down menu or hot box menu (press spacebar).

Note

You can also choose a constraint from the Constraint Type pull-down in the Solve Survey control panel. If you do, you must also click Create.

The constraint appears as an object in the view panels:
4 Set the constraint’s length or location in the 3D coordinate system.

<table>
<thead>
<tr>
<th>Constraint</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point</td>
<td>Use the perspective view or Channel box to orient and translate the constraint object. You may want to use the Maya snap tools to lock it onto a model.</td>
</tr>
<tr>
<td>Distance</td>
<td>Enter the value in the Survey control panel.</td>
</tr>
<tr>
<td>Plane</td>
<td>Use the perspective view or Channel box to orient and translate the constraint object. Refer to “Placement of Plane and Point constraints” on page 68 for more information.</td>
</tr>
<tr>
<td>Depth</td>
<td>Enter the value in the Survey control panel.</td>
</tr>
</tbody>
</table>

5 Optional: Modify the Variance setting if you want to allow some leeway for the solver to vary from the constraint settings.

**To apply survey constraints to a solution**

Follow these steps to incorporate your constraints into an existing solution. Otherwise, you can start the solver again to create a new solution.
**5 | Solving**  
*How do I? > Placement of Plane and Point constraints*

1. Open the Solve control panel.
2. Select the current solution you think is best.
3. Click the Register or Refine button.
   Register applies the constraint to the whole solution. Refine incorporates the constraint into the shape of the solution.

**Placement of Plane and Point constraints**

Plane constraints extend infinitely beyond the plane that represents them. Therefore, you can move the nurbs plane object anywhere along the plane you want to constrain.

Make sure you place constraints relative to each other as they were in real world space. For example, Plane constraints for a floor and a wall should be perpendicular. Also keep in mind that the distance you use between parallel Plane constraints implies a distance constraint.

If you use Point constraints in combination with reference geometry, use the Maya snap tools to help you place the geometry into the scene.

**Modify survey constraints**

You can modify the values of constraints at any time. However, once the constraint is created, you cannot add or remove affiliated points. You must create a new constraint that has the desired points and delete the old constraint.

| Note | If you delete a track point used in a survey constraint, Live forces the constraint to be inactive. You may need to recreate the constraint in this case. |

**Create infinite and locked points**

You can make points infinite or locked in the Locator Summary panel. These designators are another way to help the solver, like survey constraints.

To make a point infinite or locked, simply click next to the locator in the Locator Summary panel. To return a point to normal, click the icon again. See the following illustration.
Infinite

Tells the solver to treat the point as infinitely far from the camera, such as a cloud, mountain, or any feature in the distant background. Knowing a point is infinite, the solver can use it exclusively for calculating camera movement. It does not need to determine the point’s position in space, so the locator becomes hidden.

By making two or more points infinite, you can significantly help the solver calculate zoom shots, provided those points are visible long enough.

Lock

Locks the locator point to a specific 3D location. A locked point is exactly like assigning it to a survey Point constraint, but the workflow is easier. Simply click the lock icon and move or snap the locator to a given position. However, Point constraints are still required if you want it to be used for registration only.

There are several uses for locked points:

- to lock points onto a model you created or imported
- to help resolve ambiguities for the solver by specifying exact locations for two or more points, taken from survey data
- to register the whole scene around a certain point, such as the origin

Create a focal length constraint

A focal length constraint is useful for controlling the angle of view in your scene.
Determine focal length settings

The focal length settings are on the Solve Camera control panel. To help determine how to set these parameters, start by answering the following questions.

What is known about the focal length value?

- Unknown value (e.g., video shot): Set the constraint type to Unconstrained and leave the value blank.
- Known value: Set the constraint type to Fixed and enter the value. Create an animated attribute if the focal length varies.
- Estimated value: Set the constraint type to Constrained, enter the value, and enter a variance. Create animated attributes if the focal length varies.

Does the focal length zoom or remain static?

- Zoom: Uncheck the Static checkbox, which indicates the value is animated.
- No zoom (static): Check the Static checkbox, which indicates there is no animation to this value.

Example focal length settings

The following table offers examples of how to set up focal length:

Note: You must set a filmback when you create a focal length constraint. In the Setup control panel, choose from the Predefined Filmback list. See “Set up filmback and aspect ratios” on page 14 for more information.
### Example Focal Length Settings

<table>
<thead>
<tr>
<th>Shot</th>
<th>Focal Length</th>
<th>Focal Length Constraint Settings</th>
<th>Maya Live Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Film with prime lens</td>
<td>Known constant value</td>
<td>Type: Fixed</td>
<td>Maya uses your fixed focal length and keeps it constant.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Value: lens setting (e.g., 32)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Static: checked</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Variance: N/A</td>
<td></td>
</tr>
<tr>
<td>Video with zoom</td>
<td>Unknown and varying</td>
<td>Type: Unconstrained</td>
<td>Maya determines focal length and it may vary through the shot.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Value: N/A</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Static: not checked</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Variance: N/A</td>
<td></td>
</tr>
<tr>
<td>Video with no zoom</td>
<td>Unknown and constant</td>
<td>Type: Unconstrained</td>
<td>Maya determines focal length and it stays constant.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Value: N/A</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Static: checked</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Variance: N/A</td>
<td></td>
</tr>
<tr>
<td>Film with manual zoom</td>
<td>Estimated value and varying</td>
<td>Type: Constrained</td>
<td>Maya uses your animated values for the focal length within your variance.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Value: create an animated attribute</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Static: not checked</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Variance: estimated buffer</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>(e.g., 5)</td>
<td></td>
</tr>
<tr>
<td>Film with motion-controlled zoom</td>
<td>Known value and varying</td>
<td>Type: Fixed</td>
<td>Maya uses your animated values for the focal length.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Value: create an animated attribute</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Static: not checked</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Variance: N/A</td>
<td></td>
</tr>
</tbody>
</table>
Create camera translation and rotation constraints

Constraints for camera translation and rotation are also available on the Solve Camera control panel.

<table>
<thead>
<tr>
<th>Translation</th>
<th>Static</th>
<th>Rotation</th>
<th>Static</th>
</tr>
</thead>
<tbody>
<tr>
<td>X Unconstrained</td>
<td>-1.36</td>
<td></td>
<td>X Unconstrained</td>
</tr>
<tr>
<td>Y Unconstrained</td>
<td>18.29</td>
<td></td>
<td>Y Unconstrained</td>
</tr>
<tr>
<td>Z Unconstrained</td>
<td>16.34</td>
<td></td>
<td>Z Unconstrained</td>
</tr>
</tbody>
</table>

Camera translation can be constrained independently in any axis. For example, if the camera moves along the X axis only, you can lock off any translation along Y and Z by setting them to Fixed and checking Static.

For camera rotation, however, constraints apply to all axes at once. If you set a constraint on the X axis, Maya Live applies the setting to Y and Z as well. You cannot constrain for rotation in a single axis, but you can still help the solver by adding Depth constraints (see “Depth constraints” on page 65).

Render a solution

You can render your final scene with images in the background or with just the CG elements so that you can later composite them with the live footage. Compositing is the recommended approach, but both methods are supported.

In order to render the image plane, you must turn off the Use Cache option on the Setup control panel. The Use Cache option utilizes a Roto node, which does not render. By turning Use Cache off, Live switches to the standard Maya image plane, which is renderable.

To render just CG elements, you can leave the Use Cache option on or, if you turn it off, set the Display Type to None in the image plane attributes.

**Note** Before you render, click Copy to Render Globals on the Setup control panel to make sure the aspect ratios copy correctly to the Maya Render Globals.
Using CG backgrounds

If you have live action footage matted against a CG background, the background geometry may become clipped off. This problem occurs because Live places the far clipping plane immediately behind the image plane. To correct it, open the camera attributes and edit or delete the expression for the far clipping plane.

Export a solution

When you have finished a solution, you can export the solution camera and 3D locators. Use export to share with Maya Complete users or to transfer to another application. The applications supported are Softimage and Discreet Logic’s special effects products, including Inferno and Flame.

Versions supported

- Discreet: 1.4.1IR
- Softimage: 3.7. Note that the export script assumes Softimage is installed locally. If it is not local, refer to “Export to Softimage on another machine” on page 74.

To export a solution

1. Select the final solution in the Solve control panel.
2. For Maya Complete export only: Select any geometry you want to export.
3. Turn on or off the As Object checkbox as needed.
   - If As Object is not checked, Live exports an animated camera and static 3D locators. If As Object is checked, Live exports a static camera and animated 3D locators.
4. Select Scene > Export Scene As, and select either Maya Complete, Discreet, or Softimage.
5. Do one of the following:
   - Specify the file location and click Export.
   - For Softimage export only: Complete the fields described below and click Export.

Note

In some cases, Inferno and Flame require a static camera (for example, to produce lens distortion effects). To accommodate this requirement, turn As Object on. The visible result will be the same once you import into the Discreet software.
Location of Soft DB

Specifies the top-level directory containing the Softimage database. The database directory can be either local or on a network. This directory should have the following sub-directories: ANIMATION, CAMERAS, MODELS, SCENES, and SETUP_SOFT.

Prefix for Scene

Specifies the prefix of the Softimage naming scheme. For example, if you want the name to be studio-stainx1.0, enter studio as the prefix.

Scene Name

Specifies the scene of the Softimage naming scheme. For example, if you want the name to be studio-stainx1.0, enter stainx1.0 as the scene name.

Export to Softimage on another machine

The export utility assumes Softimage is installed locally on your machine. If it is not local, two issues arise:

- The export utility must be able to locate a Softimage database directory structure. You must either specify one on the network or create a dummy database directory structure.
- Some Softimage utilities are required to complete the export. You must run these utilities, hrcConvert and bin2ascii, from the command line of the machine where Softimage is installed.

The following instructions explain how to work around both issues.

Export to a dummy database directory

Perform these steps only if your machine cannot access the target Softimage database across the network. In this case, you must use a temporary, dummy database directory. Otherwise, export as usual and specify the remote Softimage database in the Location of Soft DB field.

1. Create a dummy Softimage database directory, such as LivetoSoft.
2. Create the following sub-directories under the dummy database directory:
   - ANIMATION

Note

For the Softimage export, you receive various files in the database directories (ANIMATION, CAMERAS, MODELS, SCENES, and SETUP_SOFT). When you import into Softimage, load the scene file from the SCENES directory.
How do I? > Export to Softimage on another machine

CAMERAS
MODELS
SCENES
SETUP_SOFT

Use all capitals for the directory names.

3 When you export the solution (Scene > Export Scene As > Softimage), specify the dummy database directory (such as LivetoSoft) in the Location of Soft DB field.

Run Softimage conversion utilities

Because your machine does not have Softimage installed, the export utility can only create ASCII files. You must convert several of these ASCII files to binary using Softimage utilities on your Softimage machine. Follow these instructions.

1 If you exported to a dummy database: Copy the files from the dummy database to the actual Softimage database.

./ANIMATION/scenename-cam_init1.1-0Ascii.ani
./CAMERAS/scenename-cam_init1.1-0Ascii.cam
./MODELS/scenename-pointA_3DAscii.hrc
...
./MODELS/scenename-pointZ_3DAscii.hrc
./SCENES/prefixname-scenename.1-0.dsc
./SETUP_SOFT/prefixname-scenename.1-0.sts

where scenename and prefixname are the scene and prefix names you specified in the Softimage export window. Notice that the MODELS directory contains one file for each 3D locator.

2 Log into the machine with Softimage installed.

3 Run the following command to convert the exported file in the ANIMATION directory.

bin2ascii scenename-cam_init1.1-0Ascii.ani scenename-cam_init1.1-0.ani

4 Run the following command to convert the exported file in the CAMERAS directory.

bin2ascii scenename-cam_init1.1-0Ascii.cam scenename-cam_init1.1-0.cam

5 In the MODELS directory, list all the 3D locator files you need to convert by typing the following command:

ls scenename-*_3DAscii.hrc

6 Run the following commands to convert each file in the MODELS directory.

hrcConvert scenename-pointA_3DAscii.hrc scenename-pointA_3D.hrc
5 | Solving
How do I? > Export to Softimage on another machine

... hrcConvert scenename-pointZ_3DAscii.hrc scenename-pointZ_3D.hrc

where scenename is your specific scenename and pointA and pointZ are your specific point names.

7 Leave the files in the SCENES and SETUP_SOFT directories as they are.

8 To import into Softimage, load the scene file.
## 6 Fine tune and corrections

### About

Fine tuning and corrections

Fine Tune is an optional task where you can make frame-by-frame adjustments to the camera position. (This task is rarely used.)

**Related topics**
- “Fine Tune”
- “Corrective options”

### How do I? Fine tune and correct

**Fine Tune**

Live gives you the option to fine tune the camera position of a finished solution using the tools on the Fine Tune control panel.

**Using Nudge Tools**

The Nudge Tools provide a manual method for making minor adjustments to camera position on selected frames. The adjustments you make to a solution using the Nudge Tools are automatically saved with the solution. Do not re-solve, because the solver would overwrite your adjustments.

**To adjust the camera using the Nudge Tools**

1. Open the Fine Tune control panel.
2. Go to the frame number that needs adjusting.
3. Choose the Nudge Tools button corresponding to the camera direction you want to adjust.
   - **Track** - Move the camera up, down, right, or left.
   - **Dolly** - Move the camera toward or away from image plate.
   - **Pan/Tilt** - Rotate the camera up, down, right, or left.
   - **Roll** - Rotate the camera clockwise or counterclockwise.
4. Hold down the Ctrl key and press the arrow key for the direction you want to move the camera.
   - The camera moves one increment each time you press the arrow key.
Corrective options

This section describes some of the corrections you may need to make to your scene if you encounter errors.

Correct the time unit

Be sure to set your time unit before tracking. If you forget, you can fix your tracked points by rescaling the times of the keys in the graph editor.

Choose between two methods to reset the time scale.

Method 1

1. Change to the desired Time scale in the Settings category of the Preferences window (Window > Settings/Preferences > Preferences).
2. In the Track control panel, click the Select All button.
3. In the channel box, select all fields that appear green (meaning they are animated values).
4. Choose Edit > Keys > Scale Keys.
5. In the Scale Keys Options dialog, enter the following settings:
   - Channels - Select From Channel Box
   - Time Range - Select All
   - Time Scale/Pivot - In the Time Scale field, enter the value obtained when you divide the current frame rate by the target frame rate. For example, if you want to scale from 24 fps to 30 fps, the value is 0.8. In the Time Pivot field, leave the value at 0.00.
6. After you have rescaled, run Solve again.

Method 2

1. Leaving the Time unit setting alone, save the scene, then click Save As to a Maya ASCII file.
2. Open a new scene to clear the memory.
3. In a text editor, open the ASCII scene file and find the heading "CurrentUnit" near the top of the file.
4. Change the -t flag to one of the following time units: film, game, ntsc, ntscf, pal, palf, or show.

Each time unit name represents a certain speed:

- film is 24 fps
- pal is 25 fps
- game is 15 fps
- palf is 50 fps
ntsc is 30 fps    show is 48 fps
ntscf is 60 fps

5  Save changes to the ASCII file.
6  Reopen the ASCII scene file in Maya Live.
   When you do, the track points and all solutions are scaled to the new
time unit.

Correcting the filmback setting
If you forget to set the filmback, you can fix your tracked points by
rescaling the values of the keys in the graph editor.

To adjust track point scaling for a new filmback
1  Change to the desired filmback settings in the Setup control panel.
2  In the Track control panel, click the Select All button.
3  In the channel box, select the LocationX attribute.
4  Choose Edit > Keys > Scale Keys □.
5  In the Scale Keys Options dialog, enter the following settings:
   •  Channels - Select From Channel Box
   •  Time Range - Select All
   •  Time Scale/Pivot - In the Time Scale field, enter 1.0 to keep the
time scale as is. Leave Time Pivot at 0.0.
   •  Value Scale/Pivot - In the Value Scale field, enter the value
obtained when you divide the current film aperture width into the
target width. For example, if you want to scale from 1.481 to 1.333
(NTSC video), the value is 0.9. Leave Value Pivot at 0.00.
6  To see your change in the view panel, refresh the screen.
7  After you have rescaled, run Solve again.
6 | Fine tune and corrections
How do I? > Correcting the filmback setting
Index

<table>
<thead>
<tr>
<th>exporting</th>
<th>73</th>
</tr>
</thead>
<tbody>
<tr>
<td>Live solutions</td>
<td>73</td>
</tr>
<tr>
<td>track points</td>
<td>45</td>
</tr>
<tr>
<td><strong>F</strong></td>
<td>44</td>
</tr>
<tr>
<td>Failure Behavior parameter</td>
<td>44</td>
</tr>
<tr>
<td>Failure Threshold parameter</td>
<td>44</td>
</tr>
<tr>
<td>fields</td>
<td>21</td>
</tr>
<tr>
<td>image for both even and odd</td>
<td>21</td>
</tr>
<tr>
<td>image for even or odd</td>
<td>22</td>
</tr>
<tr>
<td>file format</td>
<td>13</td>
</tr>
<tr>
<td>supported</td>
<td>13</td>
</tr>
<tr>
<td>tracked points</td>
<td>45</td>
</tr>
<tr>
<td>Film Aperture</td>
<td>16</td>
</tr>
<tr>
<td>filmback</td>
<td>79</td>
</tr>
<tr>
<td>correcting</td>
<td>79</td>
</tr>
<tr>
<td>setup</td>
<td>14</td>
</tr>
<tr>
<td>filmgrain, correcting</td>
<td>43</td>
</tr>
<tr>
<td>Filter command</td>
<td>38</td>
</tr>
<tr>
<td>Filter Level</td>
<td>61</td>
</tr>
<tr>
<td>Fine Tune task</td>
<td>77</td>
</tr>
<tr>
<td>how to use</td>
<td>77</td>
</tr>
<tr>
<td>improving solutions and</td>
<td>62</td>
</tr>
<tr>
<td>focal length</td>
<td>69</td>
</tr>
<tr>
<td>constraint</td>
<td>69</td>
</tr>
<tr>
<td>estimate</td>
<td>70</td>
</tr>
<tr>
<td>setting</td>
<td>15, 69</td>
</tr>
<tr>
<td>focal length constraint</td>
<td>70</td>
</tr>
<tr>
<td>formats supported</td>
<td>13</td>
</tr>
<tr>
<td>Frame Capacity</td>
<td>19</td>
</tr>
<tr>
<td>Frame Pixel Slip</td>
<td>55</td>
</tr>
<tr>
<td>frame range</td>
<td>14</td>
</tr>
<tr>
<td>setup and</td>
<td>14</td>
</tr>
<tr>
<td>solving and</td>
<td>51</td>
</tr>
<tr>
<td>tracking and</td>
<td>33</td>
</tr>
<tr>
<td>Frame Range parameter</td>
<td>14</td>
</tr>
<tr>
<td>frame rate</td>
<td>78</td>
</tr>
<tr>
<td>correcting</td>
<td>78</td>
</tr>
<tr>
<td>deinterlacing and</td>
<td>22</td>
</tr>
<tr>
<td>Frame Slip</td>
<td>58</td>
</tr>
<tr>
<td>full resolution images, loading</td>
<td>14</td>
</tr>
<tr>
<td><strong>G</strong></td>
<td>73</td>
</tr>
<tr>
<td>geometry</td>
<td>73</td>
</tr>
<tr>
<td>clipped off</td>
<td>73</td>
</tr>
<tr>
<td>in scene</td>
<td>50</td>
</tr>
<tr>
<td>Global Illumination parameter</td>
<td>42</td>
</tr>
<tr>
<td>Graph Editor panel</td>
<td>56</td>
</tr>
<tr>
<td><strong>H</strong></td>
<td>15</td>
</tr>
<tr>
<td>HDTV settings</td>
<td>15</td>
</tr>
<tr>
<td><strong>I</strong></td>
<td>44</td>
</tr>
<tr>
<td>Image Buffer Factor parameter</td>
<td>44</td>
</tr>
<tr>
<td>Image Depth parameter</td>
<td>14</td>
</tr>
<tr>
<td>Image option</td>
<td>19</td>
</tr>
<tr>
<td>image playback</td>
<td>19</td>
</tr>
<tr>
<td>cache and</td>
<td>19</td>
</tr>
<tr>
<td>tools</td>
<td>12</td>
</tr>
<tr>
<td>Image Zoom Factor parameter</td>
<td>45</td>
</tr>
<tr>
<td>images</td>
<td>18</td>
</tr>
<tr>
<td>cache</td>
<td>18</td>
</tr>
<tr>
<td>distortion from cache</td>
<td>20</td>
</tr>
<tr>
<td>file formats</td>
<td>13</td>
</tr>
<tr>
<td>loading</td>
<td>13</td>
</tr>
<tr>
<td>importing track points</td>
<td>45</td>
</tr>
<tr>
<td>Incremental setting</td>
<td>44</td>
</tr>
<tr>
<td>Indexed setting</td>
<td>19</td>
</tr>
<tr>
<td>infinite points</td>
<td>63</td>
</tr>
<tr>
<td>initial1</td>
<td>51</td>
</tr>
<tr>
<td>interlaced shots</td>
<td>21</td>
</tr>
<tr>
<td>filtering track points</td>
<td>38</td>
</tr>
<tr>
<td>setup</td>
<td>21</td>
</tr>
<tr>
<td>label names, displaying</td>
<td>41</td>
</tr>
<tr>
<td>Linear unit</td>
<td>20</td>
</tr>
<tr>
<td>lines</td>
<td>64</td>
</tr>
<tr>
<td>constraining to</td>
<td>64</td>
</tr>
<tr>
<td>in the track box</td>
<td>35</td>
</tr>
<tr>
<td>Live Controls</td>
<td>10</td>
</tr>
</tbody>
</table>
loading
images ............................... 13
Live plug-in ......................... 9
track points ....................... 45
Locator Summary panel .......... 58
locked points ..................... 63
long shots and tracking ....... 32
lower-resolution images as proxies . 23
luminance
and image cache ................... 19
for proxies ....................... 23

M
Make Movie parameter ........... 45
manipulation of track boxes .... 32, 33
markers
filming ............................ 30
versus natural features .......... 26
match moving ....................... 9
Maya Render Globals .......... 16
mayaLive.mll ..................... 9
mayalive.so ....................... 9
memory for images ............... 18
Movieplayer ....................... 12

N
New MatchMove ................ 9
nodal camera rotation .......... 65
None option ....................... 19
Nudge tools ....................... 77

O
object tracking
choosing features to track .... 25
Options control panel ......... 42
options for tracking .......... 42
Overall Pixel Slip ............... 55

P
PAL video and dmconvert ....... 22
performance, image cache .... 18
Pixel Aspect Ratio .............. 16
pixel slip .......................... 55, 58
Pixel Type parameter ......... 19
Plane constraints ............... 64
playback
errors ............................ 20
image cache and tools ........ 12
Playback ........................ 12
Plug-in Manager ................ 9
Point constraint
vs locked point .................. 69
Point constraints ............... 63
Pointblasts ...................... 12
pointCenteredCamera and image cache ........ 19
points
choosing ......................... 25
points file format .............. 45
Predefined Filmbacks .......... 15
production tips ................. 30
proxy images
creating ........................ 23
loading ........................... 14
luminance ........................ 23
proxy movie and cache ......... 20
range of frames .................. 33
Ready to Track button ........ 16
red lines in track box ......... 35
reference geometry ............ 50
registering a solution ....... 63
Registration only constraints .. 65
render support .................. 20
resizing track boxes .......... 37
RGB and image cache .......... 19
Root Frame solver
running .......................... 51
Index

root frames, choosing .............................. 60
Rotate Order for Maya Live ...................... 62

S

scaling solutions .................................... 63
scanlines
  interpolate on both fields ....................... 21
  interpolate on one field ....................... 22
scanned images and cropping ..................... 30
scrubbing with Time Slider ....................... 19
search box
  resizing ........................................... 37
  sizing ............................................. 34
setup
  filmback .......................................... 14
  geometry .......................................... 50
  image cache ....................................... 18
  loading images ................................... 13
  time unit ......................................... 20
  up axis ........................................... 21
  video shots ...................................... 21
shape
  of track features ................................ 26
shotCamera and image cache ...................... 19
shots, problematic ................................. 28
Show Progress Image parameter .................. 44
sizing track boxes .................................. 34
Smart setting ....................................... 44
Smoothing Interval parameter ...................... 61
smoothness
  for delace utility ................................. 22
  shown by trace lines ............................. 35
  track point filter ............................... 38
Softimage
  export solution to ................................ 73
solution
  evaluating ........................................ 55
  exporting ........................................ 73
  improving ........................................ 59
  register ......................................... 63
Solution control panel ............................. 60
solution_rf ......................................... 51
solve
  about .............................................. 49
Camera control panel .............................. 69, 72
c control panel ...................................... 50
for object movement ............................... 51
Solution control panel ............................. 60
Survey control panel .............................. 65
when to .............................................. 40
workflow ............................................ 50
solver
  running ............................................ 51
Start Tracking button .............................. 33
Static checkbox ..................................... 70
Stop Tracking On parameter ....................... 36
SubImage option .................................... 19
Subpixel Precision parameter ..................... 43
supported file formats ............................. 13
survey constraints
  choosing .......................................... 63
  color of .......................................... 41
  creating ......................................... 65
  modifying ........................................ 68
  number of ........................................ 66
  placement ........................................ 68
  when to create ................................... 66
survey data
  and choosing points .............................. 25
  production tip .................................... 30
T

target box
  resizing .......................................... 37
  sizing ............................................. 34
Texture Method ..................................... 19
Time Slider
  about .............................................. 12
  image cache and ................................ 19
time unit
  and field rate .................................... 22
  and frame rate ................................... 22
correcting .......................................... 78
required ............................................ 20
Trace Line color .................................... 42
Index

trace lines
  color of ................................................. 41
  evaluating ............................................. 35

track
  backward ................................................. 36
  basic steps ............................................ 32
  bidirectional .......................................... 37
  box tool ................................................ 32
  choosing points ....................................... 25
  deleting frames ....................................... 37
  directions .............................................. 36
  Display control panel ................................ 41
  failure .................................................. 36
  long shots ............................................... 32
  Options control panel ................................ 42
  overall workflow ....................................... 31
  purpose .................................................. 31

track boxes
  color of ................................................ 41
  errors .................................................... 20
  manipulation ........................................... 32, 33
  repositioning .......................................... 34
  resizing .................................................. 37
  sizing ..................................................... 34
  tracelines .............................................. 35
  user positioned ....................................... 37

track points
  color ...................................................... 42
  deactivating ........................................... 38
  deleting .................................................. 38
  evaluating .............................................. 35
  exporting ................................................ 45
  file format ............................................. 45
  importing ............................................... 45
  number of ............................................... 41

Track Summary
  deleting data .......................................... 37
  quality codes .......................................... 39
  solve readiness ....................................... 40

Tracking Direction parameter .......................... 36

tripod shots ............................................. 65

U
  up axis .................................................... 21
  Update Behavior parameter ............................ 44
  Update Increment parameter ............................ 44
  Update Threshold parameter ............................ 44
  Use Cache .............................................. 20
  Use Current Frame ...................................... 33
  Use Rotate .............................................. 43
  Use Scale ............................................... 43
  Use User Specified Root Frames ........................ 61
  User Tracked Frame option ............................. 36

V
  Video Source filmback ................................ 16
  video, deinterlacing ................................... 21
  visibility .................................................. 29
    duration of points ................................... 25
    trace lines ............................................ 41

W
  whip pan camera ........................................ 29
  workflow .................................................. 31
    tracking ............................................... 31
  workspace, maximizing ................................ 20
  world coordinate system ................................ 21

Y
  Y up axis ................................................ 21

Z
  Z up axis ................................................ 21
  zoom shots .............................................. 29
    and constraints ....................................... 29
    avoiding .............................................. 30